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C h a p t e r 2
 

Solid Part One 
 

 
This chapter will cover the following to World Class standards: 

 
 Sketch of Solid Problem One 
 Drawing a Rectangle 
 Drawing a Line 
 Copying the Sketch 
 Dimension and Move a Circle 
 Finish 2D Sketch of Solid Part One 
 Extrude the Sketch 
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Sketch of Solid Part One 
________________________________________________________ 
 
When receiving a sketch from a professional, the CAD technician will try to identify what 
fundamental features are hidden in the composite solid. The basic building shapes in the three 
dimensional design are rectangular or cubic box, spherical shapes, conical shapes, cylindrical 
shapes and the triangular wedge. In your first 3D solid, you might already observe that there is a 
rectangular box that measures 7 by 2.957. There are two tabs off the bottom of the rectangle with 
holes in the center. There are four holes in a rectangular pattern on the rectangle. Whatever 
procedure you use to complete the exercise, most beginners find that the Rectangle, Line and 
Circle tool on the Sketch menu provides one of the easiest methods to draw the component. 
 

 
Figure 2.1 – Problem One sketch 
 
As you have already seen from your other 2d drafting training, Inventor 2012 has a different 
interface than your previous experience in AutoCAD. So, these lessons will expose us 
techniques that will improve our sketching skills and therefore take us to 3D modeling even 
faster.  
 
Some features we will enjoy using in Inventor 2012 are changing a dimension on an entity and 
then the line or circle will move along with the altered measurement. We will enjoy drawing 
components of the part such as this front view shown in figure 2.1 and when we start to model it 
in the next chapter, we will quickly have a 3D part. So let us start to use the Inventor 2012 
program and create 3D parts and assemblies. 
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Starting a 3D Part Drawing Sketch 
________________________________________________________ 
 
When we open the AutoCAD Inventor application, we will select New from the menu. 
 

 
Figure 2.2 – AutoCAD Inventor Professional 2012 
 
A New File window will appear and there 
are four tabs on this dialogue box.  They are 
Default, English, Metric and Mold design. 
For this drawing, we will select the English 
tab and the Standard (in) ipt template. We 
will press the OK button to continue. 

  
 Figure 2.3 – Starting the drawing using the 

Standard IPT template 
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To turn off the grid on the new drawing, we will go to the Tools tab on the Ribbon and choose 
Applications Options. 
 

 
 
Figure 2.4 – Starting the drawing using the Standard IPT template 
 
In the Applications Options dialogue 
box, we will turn off the Grid Lines.  
 
For this chapter, we picked the 
Colors tab on the Applications 
Options and we select 1 background 
color and Presentation for the Color 
Scheme list. Having the grid and 
color on the drawing sketch 
background has no effect on the 
drawing, but is the designer’s 
personal preference. 

  
 Figure 2.5 – Application Options Window 
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Drawing a Rectangle 
________________________________________________________ 
 
We can sketch our design in Inventor many different ways and achieve 
the same technique. The first method we will utilize is the Two Point 
Rectangle.  

 

 
To draw a rectangle, we right click on the 
drawing and we can see Create Line, Center 
Point Circle, Two Point Rectangle and many 
more choices. We pick Two Point Rectangle 
where we will single click on the lower left 
portion of the graphical display and then pull 
the rectangle to the upper right section of the 
display. 

 Figure 2.6 – Graphical Display Menu
 

  

Figure 2.7 – Horizontal Dimension Figure 2.8 – Vertical Dimension 
 
This any sized rectangle on the graphical display has two dimensions. The horizontal 
measurement is highlighted and we can type 7. We press the tab on the keyboard to switch to the 
vertical dimension and we input 2.957. 
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Figure 2.9 – Rectangle with Two Dimensions Showing
 
 
 
Drawing your First Line 
________________________________________________________ 
 
The next entity we will learn to draw in Inventor is a Line. We right click on the 
drawing and we can see Create Line above and to the left of Two Point Rectangle.  

 

We pick Create Line and we select the first 
point on the lower left corner of the 7 by 2.957 
rectangle. We can observe two dimensions on 
the line as we pull the mouse from the corner 
of the rectangle. This is a polar dimension 
which has a length and an angle. 
  
 Figure 2.10 – Drawing a Line 
  

We type 1 for the length measurement. 

 
  
 Figure 2.11 – Length Dimension 
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We tab on the keyboard and we type 45° for 
the angle measurement. 

 
  
 Figure 2.12 – Angle Dimension 
  

We can press the Esc key to terminate the line 
or we can continue with another segment. We 
will continue with another segment and drag 
the mouse horizontally to the right. Notice the 
new segment will snap to the horizontal if the 
cursor is close to that axis. We would see a 
similar result if we were close to the vertical 
axis. 
  
 Figure 2.13 – New Line Segment 
  

For the second line segment, we will type 1. 
For the third and last line fragment, we will 
type 1 again and point the cursor on the bottom 
of the rectangle. The angle dimension will 
indicate 135°. We then draw a line to the point 
where we started and we can Enter on the 
keyboard or choose the point with the mouse. 

  
 Figure 2.14 – Third Line Segment 
 
 
 

Drawing a Circle 
________________________________________________________ 
 
Next we will learn to place a circle on the drawing. We right click on the 
graphical display and we choose Center Point Circle 
 

When we pick the Center Point Circle, we then 
point and not click on the midpoint of the 1 
inch line.  

  
 Figure 2.15 – Point to the Midpoint 
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We then move the mouse up and we will see 
two dotted lines, one horizontal and one 
vertical. We then can pick the yellow dot at the 
intersection and the circle will be in the middle 
of the tab. 

  
 Figure 2.16 – Point to the Vertical Midpoint 
  

Then we can input the diameter of the circle as 
0.25. 

  
 Figure 2.17 – Input the Diameter 
  

The finished the hole will show its dimension 

  
 Figure 2.18 – Finished Hole 
  
  
  

Adding Dimensions 
________________________________________________________ 
 
Sometimes when we add an entity, we will not see all the dimensions, so we will 
load them.  

 

We will pick the circle and the left corner of 
the tab and the 0.50 dimension will appear. 
Click to make it permanent. 

  
 Figure 2.19 – Horizontal Dimension 
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We will pick the circle and the left corner of 
the tab and this time we will pull the 
dimension to the left so the 0.354 dimension 
will appear. Click to make it permanent.  

  
 Figure 2.20 – Vertical Dimension 
 
 
 

Copying in an Inventor Sketch 
________________________________________________________ 
 
After we have drawn an single or series of entities, we can improve our efficiency 
by copying them to repeat the shape.   
 

 
Figure 2.14 – Copy on the Sketch Ribbon 
 

We select a point on the graphical display to 
the left of the rectangle being sure not to 
clicking on a line or dimension. We hold down 
the left mouse button a red rectangle will cover 
the entities we want to choose. 

  
 Figure 2.21 – Highlight the Entities  
  

We then pick the Sketch tab on the Ribbon 
menu and we select Copy. We pick the arrow 
on the right for the base point. 

  
 Figure 2.22 – Highlight the Entities  
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We will pick the junction of the 1 inch line and 
the bottom of the rectangle on the right side of 
the tab as shown in figure 2.23.  
 
We then will pick the second point of 
displacement on the lower right corner of the 
rectangle as shown in figure 2.24. 
 
All five entities are now copied and shown in 
figure 2.25. 

  
 Figure 2.23 – Base Point of Displacement 
 

 
Figure 2.24 – Second Point of Displacement 
 

 
Figure 2.25 – Finished Copying  
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Drawing another Circle 
________________________________________________________ 
 
Next we will repeat drawing a circle on the drawing. We right click on the 
graphical display and we choose Center Point Circle 
 

When we pick the Center Point Circle, we then 
point and click anywhere inside the lower left 
hand corner of the rectangle. We draw a 0.15 
diameter circle.  

  
 Figure 2.26 – Draw a 0.15  Circle 
 
 
 

Dimension and Move the Circle 
________________________________________________________ 
 
After we have drawn an single or series of entities, we want to move them to a 
precise position on the drawing . We can do that by applying the dimensions and 
changing the measurements and the entity will move its position. 

 

 

  
Figure 2.27 – Add the Vertical Dimension  Figure 2.28 – Change the Dimension  
  
We place the vertical dimension from the lower left hand corner of the rectangle and to the 
center of the 0.15 diameter circle. Our dimension shows 0.847 but your drawing can be entirely 
different. We double click on the vertical dimension and the Edit Dimension window will appear 
on the graphical display. We type 0.5 and both the dimension and the circle’s position changes. 
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Figure 2.29 – Add the Horizontal Dimension Figure 2.30 – Change the Dimension  
  
We place the horizontal dimension from the lower left hand corner of the rectangle and to the 
center of the 0.15 diameter circle. Our dimension shows 0.751 and again your drawing can be 
dissimilar. We double click on the horizontal dimension and the Edit Dimension window will 
appear on the graphical display. We type 0.1875 and both the dimension and the circle’s position 
changes. 
 
 
 

Array the Circle 
________________________________________________________ 
 
We can array an entity using a rectangular or circular pattern. The first array 
we will do is the rectangular configuration.  

 
When we select Rectangular on the Sketch 
Ribbon, we will see the Rectangular Pattern 
Window appear on the graphical display. We 
first press the Geometry arrow and select the 
circle to array. Then we pick the Direction 1 
arrow and we choose the vertical line on the 
right side of the rectangle. A green arrow will 
appear. Then we pick the Direction 2 arrow 
and we choose the horizontal line on the 
bottom side of the rectangle. Another green 
arrow will appear. When the arrows appear, we 
will see the column and row numbers go from 
greyed out to active.  
  
 Figure 2.31 – Rectangular Pattern Window 
 

Also, the associative dimension textbox will become active. We will leave the columns and rows 
textbox with 2 and 2, because we only want 4 circles total. We should know that the first hole 
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will also count. We will change the distance between rows as 1.957 and the distance between 
columns as 6.625. We press the OK command button on the Rectangular Pattern window and 
the finished part will be seen as shown in figure 2.32. 
 

 
Figure 2.32 – Array the Circle 
 

 
Figure 2.33 – The Finished Part 
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Save the drawing and we will now make a model off the sketch. To improve our sketching 
abilities, we should practice these drills until we know each function thoroughly.  
 
* World Class CAD Challenge 61-02 * - Close this drawing file.  Create a New file and 
draw the rectangle, the two tabs and insert the circles. Complete the task in less than 5 
minutes.  Continue this drill four times, each time completing the drawing under 5 minutes 
to maintain your World Class ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
 
 
 

Finish 2D Sketch of Solid Part One 
________________________________________________________ 
 
Before we extrude the sketch, we need to right click on the graphical display 
and on the menu, we choose the Finish 2D Sketch button. 
 

 
Figure 2.34 – Finished Part One Sketch
 
 
 

Extruding a 3D Sketch 
________________________________________________________ 
 
Now that we have a finished sketch, we need to extrude the part. We can go ahead 
and pick the Extrude button on the Model tab of the Invertor ribbon. The Extrude 
window will appear on the display. 
  
On the Extrude window, we can output either a solid or surface. The difference between the two 



2-15 

are that the first is like a hard piece of wood and the second choice is similar to a box. We will 
pick the Solid output on the left. Next, our part will be made from 0.5 finished wood, so we will 
change the Extents distance from 1.0 to 0.5. 
  

 
Figure 2.35 – The Extrude Window 
 

Next, we will click on the right tab and it 
will become highlighted in red. Click on the 
red area again and the 2D polygon will 
become a solid with a hole where the circle 
was located.  

  
 Figure 2.36 – Highlight Right Tab 
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Then, we will click on the left tab and it will 
become highlighted in red. Click on the red 
area again and the 2D polygon will become a 
solid with a hole where the circle was 
located. 

  
 Figure 2.37 – Highlight Left Tab 
  

Now, we will click on the rectangular section 
and it will become highlighted in red. Click 
on the red area again and the 2D polygon 
will become a solid with a holes where the 
four circles were located. 

  
 Figure 2.38 – Highlight Plate 
  

The last step is to press the OK button on the 
Extrude window. 

  
 Figure 2.39 – The Solid Part 
  
Save the drawing and we will now have a solid part to be used on a project.  
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Figure 2.40 – Finished Solid  
 
 
 
* World Class CAD Challenge 61-03 * - Close this drawing file.  Create a New file and 
draw the rectangle, the two tabs and insert the circles. Extrude the part. Complete the task 
in less than 7 minutes.  Continue this drill four times, each time completing the drawing 
under 7 minutes to maintain your World Class ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 

 


